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Please Note:  All Meetings will now be  on the second  
Tuesday of each month.  Starting at 3:00 P.M.  
Location:  Christ Lutheran Church 

481 Snead Drive, Fairfield Glade TN 

 

August  12th Program  
&  3:00 P.M. 

 

George Sengstock will again be 
directing this months open forum. 
 
Members: George Sengstock will 
share with us his two big problems 
he had last month and how he 
fixed them.  
 
Please bring your questions and 
devices for a hands on forum on 
PCs and mobile devices. 
   
I implore members to think about 
technology issues they recently 
have had and form statement and/
or questions about an experience 
you have had. 
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Join the Club! 
Anyone interested to attend the general meeting or any of 
the SIG meetings as a guest will be charged $3.00 per per-
son for any or all meetings in that month. Afterwards, you 
are encouraged to become a member of the Plateau PC 
Users Group.  Our Club cannot exist without you, the 
members.  
  

Membership Dues  
Our annual dues are now payable July 1st. of each year.  
Annual  dues are $24 per single person / $30 per family.  
Persons/families joining during the fiscal year have dues 
payable as follows: 
 

 
 

 
BOARD OF DIRECTORS DISCLAIMER 

All members of the Plateau PC Users Group are willing 
to help one another in the area of advice and tutorial in-
struction over the phone.  If you should require more in-
volved services or instruction, we have a few members 
who are very knowledgeable in several areas.  As a re-
sponsible  
consumer, it is up to you to discuss, before retaining a 
member, any and ALL charges for repair services and 
time consuming tutorial activities. 
 
It is not the desire of this Board of Directors to set fees 
for individuals for services rendered, nor the responsibil-
ity to intervene between members who enter into a con-
tract among themselves. 
 
The GAZETTE is published using the following:  Mi-
crosoft Word, Microsoft Publisher, and Microsoft Win-
dows.  The Gazette is the monthly newsletter of the Plat-
eau PC Users Group, Inc. 
 
DISCLAIMER:  No warranty, express or implied, is 
made by the PPCUG, the Gazette editorial staff or its 
contributing editors.  This extends to all losses incidental 
or consequential from the use or non-use of any infor-
mation in any issue of the Gazette. 
 
All images used in the newsletter, website, blogs, class 
materials or handouts (“media”)  are obtained from a “free 
use” source, preferably images that have been released as 
“CCO Public Domain”. 

 
 
 

 

PPCUG, Inc. 2025-2026 Board Members 

 Join In 
July - 
Sept 

Oct - 
Dec 

Jan - 
Mar 

Apr - 
June 

Single $24 $18 $12 $6 

Family $30 $22 $15 $7 

President George Sengstock (224) 760-3948 

Vice-President/  Charlie Merrick (931) 210-8013  

Treasurer Richard Del Frate (931) 456-2251 

Secretary Richard Del Frate (931) 456-2251 

Membership George Sengstock (224) 760-3948 

Publicity George Sengstock (224) 760-3948 

Gazette Editor Gordon Botting (931) 456-2184 

APCUG Rep  George Sengstock (224) 760-3948 

Equipment  
Custodian 

 Bob Willis (931) 456-6511 

Webmaster Alan Baker  (931) 239-0877 

Directors at Large 

Alan Baker Gordon Botting Jim Buxton   

Barbara Duncan 
 
Bob Willis 

Richard Del Frate 
 
 

Randy Knowles 

Printed by, Business Equipment Clinic 
539 West Ave. Suite 101  Crossville TN 38557 
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** Visit the PPCUG Website ** 
At: www.PPCUGinc.com.Read all about our club activities and scheduled monthly meetings, also current and past  
issues of the  Gazette Newsletter. Links also to the Meeting Handouts on past presentations. 
Send your comments and suggestions to the PPCUG Webmaster,  
Alan Baker @ jackal33980@gmail.com  (931) 239-0877 

Cool Things 

Windows 11 has new keyboard shortcuts 

 

 
 

Learn New Keyboard Shortcuts and they're worth learning 

:• Windows Key-W to open the Widgets panel 

• Windows Key-A to access the Quick Settings 

• Windows Key-Z to access Snap Layouts 

• Windows Key-K to cast media 

A couple of the best keyboard shortcuts are still in place from Windows 10, including Windows Key-V 

 to show clipboard history and Windows Key-Shift-S for the screenshot tool. 
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Clipboard History 

 
1. Save text and images you frequently copy-paste 

Windows has a little-used Clipboard History feature that can be a big productivity use. But one of its most 
interesting features isn't the "history" part at all — it's the pinning feature. 

➜ The Clipboard History will let you save text snippets and images so you can conveniently paste them in 
the future, and it can be a big productivity boost if you find yourself frequently copy-pasting the same 
things. 

➜ First, copy some text or an image to your clipboard. Then, press Windows+V to open the Clipboard 
History popup. 

(If you haven't turned on Clipboard History before, you'll be prompted to do so. Clipboard History will 
only save things to your local PC by default.) 

Then, click the little "Pin" button next to an item in your history to save it. (On Windows 10, click  

the "..." menu first and then click "Pin.") 

 

To quickly paste a saved bit of text or an image in the future, just press Windows+V to open Clipboard 
History. Then, click the item you want to paste — or use the arrow keys and the Enter key to select it. 

2. Minimize all windows except the current one  

Have you ever wanted to clean up your desktop, minimizing all the windows except the one you’re cur-
rently using? There’s a shortcut for that! 

➜ It works similarly to the odd “Aero Shake” feature that lets you grab and shake a window’s title bar to 
minimize other windows — but with much less shaking windows around. 

Just press Windows+Home — that’s it! Windows will minimize all windows except the current one. 

On some more compact keyboards, the Home key might be combined with another key. In this case, you 
might have to press something like Windows+Fn+Home instead. 
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Microsoft Word: Working with the Navigation Pane 

Microsoft Word Tips & Tricks 

 

The time-saving Microsoft Word Navigation Pane offers an easy way to view all the pages, sections, or 
search results within an entire document, which is especially helpful if you work with long documents. In 
addition, you can use the Navigation Pane to search for text, pictures, and other elements and to rearrange 
sections by heading. The Navigation Pane has three key areas: 

· Results 

· Pages (thumbnails) 
· Headings 

To work with the Navigation Pane: 

 

1. Select the View tab on the Ribbon and click the Navigation Pane check box in the Show group to 
select it. The Navigation Pane opens on the left side of your Word workspace. 
-OR- 

2. The Navigation Pane also opens whenever you launch a Find command. So, let’s look at that op-
tion. 

Searching in Word and Viewing the Results 
 

To search for something in Word: 

 

1. From the Home tab on the Ribbon, click Find in the Editing group or press [Ctrl] + F. Launching 
the Find command automatically opens the Navigation Pane even if it isn’t already open. 

2. Start typing the word or phrase you want to find in the Search Document text box. Then, in the 
Navigation Pane, Word immediately lists all matches, including the surrounding text, and the 
matches are also highlighted in the document. 

3. Pick any match in the Results tab to move to that item in the document. Next, choose other tabs in 
the Navigation Pane to navigate based on headings or pages instead of results: 

(Continued on page 6) 



 
Gazette August 2025                             www.PPCUGinc.com                                                  Page  6  

· Click the Pages tab, and all pages that contain at least one match are displayed. Click any page to 
move to it. 

· Click the Headings tab, and all headings that contain at least one match are highlighted. Then, 
click any item in the pane to move to that location. Note: This section only includes entries if 
Heading styles have been applied to the document. 

 
Advanced Find Options 

 

When working with the Microsoft Word Navigation Pane, your searches don’t have to only be for a word 
or a phrase. 

To expand your search options: 
 

1. First, look for the magnifying glass to the right side of the search box near the top of the Naviga-
tion Pane. 

2. Next, click on this magnifying glass to look for other elements within lengthy documents, includ-
ing Options and Advanced Find, which are handy if you want to control the context of the search 
phrase or perhaps specify how capitalizations are used. 

3. Other choices include the Replace command and searching for document elements 
like Graphics and Tables. 

4. Review results in the Navigation Pane. 
Easy Navigation with Pages 
 

To navigate a document with thumbnails: 
 

It’s also simple to move through a long Word file by displaying document thumbnails with Pages in the 
Word Navigation Pane. 

1. To navigate through the pages of a multi-page document, click the Pages tab in the center. 
2. Click any page icon to move to that page. The selected page is now displayed in the primary doc-

ument window. 

When you have searched for something with the Find feature, the list of pages shown dynamically filters 
to display only the pages that contain the term or document item (table, chart, image, etc.) that was part of 
the search. 

Although you can rearrange text with the Headings view, you cannot rearrange pages using the thumb-
nails in the Navigation Pane. 
Navigating and Rearranging Headings 

(Continued from page 5) 
 

(Continued on page 7) 
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If Heading styles are applied to the document, the Headings view of the Word Navigation Pane displays a 
series of nested “tabs,” each corresponding to a heading in the document. The Navigation Pane also makes 
it easy to move to or rearrange headings and related content within the document. 

To work with document headings: 

1. To browse through a document containing headings, click the Headings tab on the far left of the 
Navigation Pane. 

2. Click any heading to move to that part of the document. To rearrange the headings, simply drag 
them up or down in the list. 

Try these options to use the Microsoft Word Navigation Pane to search, view, rearrange, and navigate long 
documents. 

 
 
 

Could not create the work file” error in Office 
From, Tami Sengstock 

· I just recently got this whenever I opened an existing Word document. 
· Nothing fixed it until I did the registry edit at the end ! 

Article attached. 

Symptoms 
When you try to preview or save a document, Word returns the following error message: 
Word could not create the work file. Check the temp environment variable. 
Resolution 
Scan for malware and disk errors 

1. Run an antivirus scan. If your antivirus program doesn’t detect any malware, check for corrupted 
files or disk errors. 

2. Open an elevated Command Prompt window. To do this, select Start, enter cmd, and then press 
Enter. 

3. In the search results, right-click Command Prompt, and then select Run as administrator. 
4. Enter sfc.exe /scannow, and press Enter. 
5. After the check is done and any errors are repaired, enter chkdsk /r /f, and then press Enter. 
6. Restart your device, and try the action in Word again. If the error still occurs, try the next method. 

 
Add an Environment Variable 

1. Select Start > Settings > System > About. 
2. Scroll down to Related settings, and then select Advanced system settings. 
3. Select Environment Variables. 
4. Under User variables for <username> (where <username> is your user name), select 

the New button. 
5. In the Variable name field, enter %userprofile%. 
6. In the Variable value field, enter C:\Users\<username> (where <username> is the same value 

as <username> in step 4). 
7. Select OK, and then select OK on any confirmation window that opens. 
8. Restart your device, and try the action in Word again. If the error still occurs, try the next method. 

 

(Continued from page 6) 
 

(Continued on page 8) 
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Create a Temporary Internet Files folder 
1. Start Windows Explorer. 
2. Navigate to the following folder: 

C:\Users\<username>\AppData\Local\Microsoft\Windows\INetCache 
Note: In this path, <username> represents your user profile name. 

3. Create a folder, and name it Content.Word. 
Note: It might be necessary to turn on Hidden Items on the View ribbon of Windows Explorer. 

4. Restart your device, and try the action in Word again. If the error still occurs, try the next meth-
od. 

5. Turn off Preview pane or edit registry 
 

To work around the issue, turn off the Preview pane in File Explorer. 
 

 
 
If you want to keep the Preview Pane active, edit the following registry subkeys to fix the error. 
  
Important 
Follow the steps in this section carefully. Serious problems might occur if you modify the registry incor-
rectly. Before you modify it, back up the registry for restoration in case problems occur. 
To work around this issue, delete the following registry keys: 

1. Select Start > Run. 
2. Enter regedit in the Open: box, and then select OK. 
3. Search for and delete the following registry subkeys: 

· Word Preview: HKCR\CLSID\{84F66100-FF7C-4fb4-B0C0-02CD7FB668FE} 
· PowerPoint Preview: HKCR\CLSID\{65235197-874B-4A07-BDC5-E65EA825B718} 
· Excel Preview: HKCR\CLSID\{00020827-0000-0000-C000-000000000046} 

 Close Registry Editor, and restart Windows. 
 

(Continued from page 7) 
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Windows Tips: Must Know Windows Editing Shortcuts 

Keyboard Shortcuts, Microsoft Windows Tips & Tricks 
 

Although Microsoft Windows is designed for touchscreens, thanks to a slew of keyboard shortcuts, it’s 
easy to bypass touch and use just a keyboard and mouse. These Windows editing shortcuts can save you 
time and effort by letting you use keys instead of clicking on drop-down menus. Try these shortcuts with 
your most frequently used Windows programs, including Microsoft Excel, Word, Outlook, PowerPoint, 
OneNote, as well as many Microsoft 365 applications. 
Note: These shortcuts work with Microsoft Windows 11 and Windows 10. 
 
Windows Selecting Keyboard Shortcuts 

·  
· Select all items in a document or window: [Ctrl] + A 
· Select more than one item in a window or on the desktop, or select text within a document: [Shift] 

with any arrow key 
· Select blocks of text by paragraph: [Ctrl] + [Shift] with any arrow key 

Keep holding down [Ctrl] + [Shift], and each time you hit the arrow key successively, more para-
graphs are highlighted. 

· Selects all text from the cursor to the end of the document: [Ctrl] + [Shift] with the [End] key 
· Selects all text from the cursor to the beginning of the document: [Ctrl] + [Shift] with the [Home] 

key 
 

Windows Text and File Management Keyboard Shortcuts 
· Copies selected text or item: [Ctrl] + C 
· Cuts selected text or item: [Ctrl] + X 
· Pastes text or item on clipboard to your cursor location or designated file location: [Ctrl] + V 
· Undo something: [Ctrl] + Z 
· Redo something: [Ctrl] + Y 
· Save a document: [Ctrl] + S 
· Print a document: [Ctrl] + P 

 
Windows Formatting Keyboard Shortcuts 

· Turn on or turn off bold: [Ctrl] + B 
· Turn on or turn off italics: [Ctrl] + I 
· Turn on or turn off underline: [Ctrl] + U 

 
Windows Navigation Keyboard Shortcuts 

· Move the cursor to the beginning of the next word: [Ctrl] + Right arrow 
· Move the cursor to the beginning of the previous word: [Ctrl] + Left arrow 
· Move the cursor to the beginning of the next paragraph: [Ctrl] + Down arrow 
· Move the cursor to the beginning of the previous paragraph: [Ctrl] + Up arrow 

 



 
Gazette August 2025                             www.PPCUGinc.com                                                  Page  10  

Microsoft Windows 11 Copilot: how not to remove it 
 
The horse's mouth, Copilot AI, did not answer my how-to-remove question accurately or completely. 
by John Krout, Newsletter Contributor and Presenter 
Potomac Area Technology And Computer Society 
https://patacs.org/  
 
Introduction 

Automatic installation of un-requested software is a behavior that I do not favor. 

Microsoft forced a double whammy on my Windows 11 desktop computer on February 17. 

The February 17 PATACS+OPCUG joint monthly meeting was Zoom-only due to adverse weather. At 
about 3 PM during that meeting, Zoom froze on my computer, and a minute later, it was apparent the en-
tire computer was frozen. I pulled the power plug and then re-inserted it. When starting up, the computer 
installed a Windows 11 operating system update, displaying an increasing completion percentage. The 
download of that update probably caused the initial freeze. 

 

After about 10 minutes, I was able to rejoin the Zoom meeting. 

After the meeting, I checked Settings on that computer. I found what I expected: long ago, I had used Set-
tings to create a "NO UPDATES" time range of 9 AM to 2 AM daily. Microsoft led me to have faith in 
that setting and then clearly ignored the setting. 

One day after the meeting, I found an unfamiliar icon in the right corner of my Windows 11 gray taskbar. 
You can see it in illustration 1. The icon is on the right and includes the letters PRE. 

A click on the icon revealed a "preview" of Microsoft Copilot, their generative Artificial Intelligence (AI) 
brand. Either a left-click or right-click on the icon opened a tall, thin dialog window, inviting me to ask a 
question. 

 

I also found a scalable Copilot logo graphic in the C:\Windows folder tree. You can see that in  
illustration 2. 
 
Obviously, Microsoft wants to beat its generative AI competitors to desktops. The competitors include 
mega-firms like Google, Adobe, and Autodesk and startups like OpenAI. 

(Continued on page 11) 
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Where does AI do its work? 

In a nutshell, today and for the indefinite but no doubt long future, AI will be executed on servers, not your 
computer. Personal computers just don't have the hardware for storage and execution of generative AI. 

Consider the following consequences of that situation. 

First and foremost, those servers will capture and retain EVERYTHING you use AI to accomplish, and 
maybe a lot more (see third consequence). The owners of that AI service and servers will seek to monetize 
that valuable information about you.  

I am against such monetization. 

Second, AI services won't be available everywhere because the Internet is unavailable everywhere. Cer-
tainly not where cell towers are blocked by terrain or are overloaded. And laws may prohibit the use of 
generative AI in some locations, especially overseas. 

The third consequence is speculative, I admit. I wonder if Copilot will be running behind the scenes, invis-
ible to the user, monitoring the use of non-Microsoft apps, listening to conversations through microphones, 
and watching through webcams. Microsoft sees profit in such behaviors.  

I see violations of privacy and unwarranted use of bandwidth that I pay for. 

My first interactive generative AI experience 

You can see my dialog with Copilot below. My input is identified as You. I added italics to clarify the two 
major sub-headings in the generative AI answer.  

As you will see below in the dialog, the answer was incomplete. Perhaps I should have asked how to re-
move the Copilot preview from my computer. Maybe I should be glad that the AI could not read my mind. 

You: 

how to remove the Copilot preview 

Copilot: 

Certainly! If you'd like to remove the Copilot preview from your Windows 11 taskbar, there are a couple 
of options: 

Remove Copilot from Taskbar (Temporary): 

This method will hide the Copilot icon from your taskbar without completely deactivating it. 

Follow these steps: 

Open the Settings app (you can search for it in the Start menu). 

Click on Personalization. 

(Continued from page 10) 

(Continued on page 12) 
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Scroll down and select Taskbar. 

Toggle off the Copilot option. 

Disable Copilot Completely (Permanent): 

If you want to permanently disable Copilot, follow these steps: 

Click on Start and search for gpedit to open the Group Policy Editor. 

In the left-hand panel, navigate to User Configuration > Administrative Templates > Windows Compo-
nents > Windows Copilot. 

Double-click on Turn off Windows Copilot in the right-hand panel. 

Click Enabled, then click Apply and OK. 

Remember that if you ever want to enable Copilot again, you can follow the same steps and choose "Not 
configured" or "Disabled" instead of "Enabled" in the last step. 

That's it! If you need further assistance with Windows, feel free to ask. ➜ 

<end of dialog> 

I did try the permanent removal option. I encountered a problem: gpedit was not found on my Windows 11 
computer. I searched on the Windows Store and did not find it there. It appears to be part of Windows 11 
Pro only. I am disappointed that Copilot did not say so. 

I searched the Web and found a page of scripts for installing gpedit, one for Windows 10 and one for Win-
dows 11. When the script is finished, I can start Gpedit by typing Gpedit.msc in the Windows 11 search 
field. 

Using the remaining instructions, I could find and complete the steps. Alas, the icon remained active after 
that, so I assumed a restart was also required, which was also not mentioned by Copilot. When the comput-
er restarted, the icon was indeed no longer in the taskbar corner. 

Copilot is also found elsewhere on the computer. 

A day later, I found the Copilot icon  

(Continued from page 11) 

(Continued on page 13) 
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in another place, the popup that appears when the Search field in the taskbar is clicked. You can see that 
second icon in the upper right corner of illustration 3. The second icon does not contain the letters PRE. 

And yes, that second icon is active. Using gpedit to disable Copilot, as described by Copilot, did not re-
move or disable the second icon. 

I decided not to include the URL for gpedit installation scripts in this article because using GPEDIT did 
not remove the Copilot icon anywhere other than on the right end of the taskbar. 

More Web research followed. I found a page on which a registry edit was described to disable Copilot. I 
tried that registry edit method. It did not work for me. 

I opened Windows Settings and used Search to find references to Copilot in Settings. None were found. 
The same not-found result happened in the Windows Control Panel. 

Is removal from a computer not possible? 

My Web research also turned up a Microsoft forum page on removing Copilot. A Microsoft rep posted an 
answer repeating the gpedit technique and reiterated a familiar refrain: Copilot is now a part of the Win-
dows 11 OS and cannot be removed. 

In court many years ago, Microsoft sang that same song about an earlier version of Windows and the In-
ternet Explorer (IE) Web browser. Microsoft claimed IE could not be removed without seriously harming 
the Windows OS. An outside expert demonstrated in court how to remove IE without impacting the Win-
dows OS. In short, Microsoft may have believed that the company made IE removal from Windows im-
possible, but the company was proven wrong. 

Microsoft may have learned much since then, but so have outside experts who use critical thinking skills 
to test and challenge Microsoft's claims. Perhaps the story of Copilot and its removal of it is just begin-
ning. 

Microsoft has demonstrated that it is willing to install what the company considers the latest Microsoft 
killer app without giving its Windows customers a choice before or after the installation. Giving cus-
tomers a choice might limit Microsoft's profit potential.  

That lack of a choice shows that Microsoft does not treat customers respectfully. 

ABOUT THE AUTHOR: John Krout is a retired software engineer who has worked on contracts for many 
Federal agencies in the Washington DC metro region. He began writing and speaking about creative uses 
of personal computers in the early 1980s. More recently, he has also covered interesting uses of 
smartphones, tablets, and electric vehicles. He lives in Arlington, VA. John is also an avid photographer 
and recently enjoyed a trip to Texas to photograph the eclipse,  

 

 

(Continued from page 12) 
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How to Create Easy PDF Documents in Microsoft Office 

Microsoft Office Tips & Tricks 

 

Did you know that you can create a PDF document in Microsoft Office without Adobe Acrobat? Con-
verting a file to a PDF helps preserve formatting, fonts, and layout and makes it more difficult to change 
the document. Although Acrobat offers many additional features, the built-in PDF option in Microsoft 
Office may be all you need if you’d like to quickly create a PDF document from Microsoft Word, Excel, 
or PowerPoint. (This option is available in all recent versions of Microsoft Office, including Office 365, 
Office 2021, Office 2019, and Office 2016.) 

 

To create a PDF from Microsoft Office: 

1. Open an existing Word document, Excel workbook, or PowerPoint presentation. 

2. Choose the File menu and pick Export. 

3. From this option, click Create PDF/XPS Document, and then from the right pane, click 
the Create PDF/XPS button. 

4. Enter an appropriate name and location and click Publish to convert the document into PDF  
 format. 

 

That’s it! Try these easy steps to create your next PDF file. 

 

Although you may not need Adobe Acrobat for simple documents, when do you need Acrobat or similar 
programs? 

· Creating fillable forms 

· Controlling document security 

· Applying redaction features 

· Working with commenting and reviewing features 

· Creating and managing a PDF from multiple sources 
· Applying and reviewing document accessibility (Section 508-compliance) 
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Revised April 2025 

 
Plateau PC Users Group, Inc.  

 

 Application for Membership for 2025-2026 
   
            ------- New Member    ------ Renewing Member 
 
Return this application with a check for annual dues payable to “PLATEAU PC USERS GROUP”  
Return to the club Treasurer during our meeting or mail to  
“PPCUG Treasurer. 221 Tomlon Road, Crossville TN  38555” 
 
Our annual dues are now payable July 1st. of each fiscal year.  
  
Persons// families joining during the fiscal year have dues payable as follows: 
 

 
 
Date: --------------------               Amount Paid: $ --------------------   by Cash ------ , or Check (# ----------------------- ) 
 
 
--------------------------          -------------------------      -------------------------------------------- 
Last Name   First Name  Family Member (if family membership) 
 
------------------------------------------------------------------------------- 
Address: 
 
--------------------------------------        --------           ---------------    (-------------) ----------------------------- 
City     State  Zip Code Phone Number 
 
E-Mail address: ---------------------------------------------------------------------- 
    Please Print 
 
I have belonged to a Computer Club before:  Yes -----------     No ------------  
 
I have used PC’s since (year): ------------------  
 
I have knowledge in the following areas that I would be willing to share with club members: 
 

 
 

 
 

 
 

 Join In July - Sept Oct - Dec Jan - Mar Apr - June 

Single $24 $18 $12 $6 

Family $30 $22 $15 $7 
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September 2025 

Sun Mon Tue Wed Thu Fri Sat 

 1 2 3 10:00 A.M. 
PPCUG 
Board Mtg. 

4 5 6 

7 8 9 3:00 P.M. 
General Mtg. 
Presentation.  
Followed by 
Q&A Session 

10 11 12 13 

14 15 16  17 18 19 20 

21 22 23 24 25 26 27 

28 29 30     


